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СПИСОК ОБОЗНАЧЕНИЙ, СОКРАЩЕНИЙ И СИМВОЛОВ 

D, d –  диаметр, м; 

F – площадь, м
2
; 

G –  массовый расход, кг/с; 

P –  давление, Па; 

P –  площадь, м
2
; 

T – температура, К; 

V –  объем, м
3
; 

W –  скорость, м/с; 

X, Y –  текущие координаты, м; 

 –  плотность, 3м
кг ; 

t –  время, c; 

3D – трехмерная задача; 

CAE (Computer-aided engineering) – компьютерный инженерный анализ; 

CAD (Computer-aided design) – система автоматизированного 

проектирования;   

CFD (Computational fluid dynamics) – вычислительная гидродинамика; 

k-ε – двухпараметрическая модель турбулентности. 
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ВВЕДЕНИЕ 

 

Наибольшее распространение в системах пылеочистки получили 

циклоны. Циклоны широко применяются для очистки от пыли 

вентиляционных и технологических выбросов во всех отраслях народного 

хозяйства. На практике система улавливания частиц создается путем 

придания запыленному потоку закрученного или вращательного движения, 

ограниченного цилиндрическими стенками. Частицы осаждаются при 

отбрасывании на стенки. Такое устройство называется циклоном. 

Эффективность очистки газа в циклонах в основном определяется 

дисперсным составом и плотностью частиц улавливаемой пыли, а также 

вязкостью газа, зависящей от его температуры. При уменьшении диаметра 

циклона и повышении до определенного предела скорости газа в циклоне 

эффективность очистки возрастает. Поэтому диаметры серийно выпускаемых 

циклонов не превышают 5 м. Циклоны, как правило, используют для грубой 

и средней очистки воздуха от сухой неслипающейся пыли. Принято считать, 

что они обладают сравнительно небольшой фракционной эффективностью в 

области фракций пыли размером до 5…10 мкм, что является основным их 

недостатком. Однако циклоны, особенно циклоны высокой эффективности, 

улавливают не такую уж малую часть пыли размером до 10 мкм - до 80 и 

более процентов. 

В современных высокоэффективных циклонах, в конструкции которых 

учтены особенности улавливаемой пыли, удалось существенно повысить 

общую и фракционную эффективность очистки. 

В этом пособии рассматривается построение простой геометрической 

модели циклона, наложение на ее конечно-элементной сетки, и 

моделирование вихревых процессов в ANSYS Fluent. В качестве рабочего тела 

используется поток воздуха, загрязненный пылью. 
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1 ПОСТРОЕНИЕ ТРЕХМЕРНОЙ МОДЕЛИ ЦИКЛОНА С 

ИСПОЛЬЗОВАНИЕМ ПРОГРАММЫ ANSYS GAMBIT 

 

Построение геометрической модели циклона выполняется в ANSYS 

Gambit, используя элементарные объемные фигуры. На рисунке 1.1 показаны 

размеры циклона. На рисунке 1.2 показаны все элементарные объемные 

фигуры, используемые для построения циклона путем их соединения при 

помощи булевых операций. 

 

Рисунок 1.1 – Размеры циклона 
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Порядок и процедуры построения трехмерной модели циклона очень 

просты. Во-первых, создаются и передвигаются основные объемные фигуры, 

представленные на рисунке 1.2. Затем используются булевы операции 

«объединения» и «вычитания» для  создания единого объема, 

представляющего циклон. Ниже представлен алгоритм создания трехмерной 

модели циклона в ANSYS Gambit. 

 

Рисунок 1.2 – Простые объемные фигуры для создания циклона 

 

1.1 Запуск программы ANSYS Gambit 

Как отмечалось выше, построение трехмерной модели осуществляется 

в программе ANSYS Gambit. Ее запуск осуществляется нажатием на 
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соответствующий ярлык на рабочем столе или из меню «Пуск» ОС 

«Windows»: 

Пуск  Все программы  Fluent Inc Products  Gambit 2.4  Gambit 

2.4 

В результате этого действия появится окно, изображенное на 

рисунке 1.3. В нем в поле Working Directory необходимо выбрать папку, в 

которой будут сохраняться модели в данной сессии. После этого следует 

нажать кнопку Run. Это приведет к появлению окна программы ANSYS 

Gambit. Оно показано на рисунке 1.4. 

 

Рисунок 1.3 – Стартовое окно программы ANSYS Gambit 

 

 

Рисунок 1.4 – Окно программы ANSYS Gambit 
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1.2 Задание имени модели 

Для определения имени модели в верхнем меню нужно выбрать 

следующие пункты:  

File  New.  

Появится диалоговое окно, изображенное на рисунке 1.5.  

 

Рисунок 1.5 – Меню создания новых моделей 

 

 В графе ID набирается имя модели латинскими буквами (например, 

cyclon).  

 Выбор имени подтверждается нажатием кнопки «Accept». 

После этого действия появится окно, уточняющее согласен ли 

пользователь закрыть предыдущую сессию. В нем следует нажать кнопку 

«Yes»
1
. После этого в верхнем левом углу окна программы появится 

выбранное имя модели. 

 

1.3 Назначение программы, в которой будет происходить решение 

рассматриваемой задачи 

От этого выбора зависит набор доступных граничных условий. В 

данной лабораторной работе расчет характеристик будет происходить в 

программе ANSYS Fluent. Поэтому в верхнем меню следует выбрать: 

Solver  Fluent 5/6. 

 

                                                 
1
 Если до создания новой модели производилась работа над другой моделью и ее необходимо 

сохранить перед закрытием, то следует нажать кнопку «Save current session» в этом же окне (рисунок 1.5). В 

результате старая рабочая сессия будет сохранена. Работа параллельно с двумя моделями в ANSYS Gambit 

невозможна. 
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1.4 Построение базовых объемных фигур 

а) Меню построения цилиндрического объема (рисунок 1.6) вызывается в 

главном меню с помощью команды: 

Geometry → Volume → Create Volume → Cylinder 

Где необходимо ввести размеры фигуры: 

Height = 0.5, Radius 1 = 0.3, Radius 2 = 0.3 

Для выполнения операции нужно нажать кнопку «Apply» 

 

Рисунок 1.6 – Меню создания цилиндрического объема 

 

б) Меню построения объема усеченного конуса (рисунок 1.7) вызывается в 

главном меню с помощью команды: 

Geometry → Volume → Create Volume → Frustum 

Где необходимо ввести размеры фигуры: 

Height = 1.0, Radius 1 = 0.3, Radius 2 = 0.3, Radius 3 = 0.1 

Для выполнения операции нужно нажать кнопку «Apply». 
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Рисунок 1.7 – Меню создания объема усеченного конуса 

 

в) Далее необходимо выполнить перемещение объема усеченного конуса: 

Geometry → Volume → Move/Copy/Align 

Удерживая клавишу Shift, выбирается мышью созданный усеченный 

конус: Volume 2 (рисунок 1.8). Обязательно нужно отметить, чтобы были 

включены опции Move, Translate. 

Координаты перемещения: Х = 0, Y = 0, Z = 0.5 

Для выполнения операции нужно нажать кнопку «Apply». 
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Рисунок 1.8 – Меню создания объема усеченного конуса 

 

г) Создается следующий цилиндрический объем: 

Geometry → Volume → Create Volume → Cylinder 

Размеры: Height = 0.05, Radius 1 = 0.1, Radius 2 = 0.1 

Для выполнения операции нужно нажать кнопку «Apply» 

д) Также выполняется его перемещение: 

Geometry → Volume → Move/Copy/Align 

Удерживая клавишу Shift, выбирается мышью созданный цилиндр: 

Volume 3. Обязательно нужно отметить, чтобы были включены опции Move, 

Translate. 

Координаты перемещения: Х = 0, Y = 0, Z = 1.5 

Для выполнения операции нужно нажать кнопку «Apply» 

е) Аналогичным образом создаются два цилиндра: 

Размеры и координаты перемещения для первого соответственно: 

Height = 0.15, Radius 1 = 0.2, Radius 2 = 0.2 

Х = 0, Y = 0, Z = 1.55 
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Размеры и координаты перемещения для второго: 

Height = 0.8, Radius 1 = 0.1, Radius 2 = 0.1 

Х = 0, Y = 0, Z = -0,2 

Для выполнения каждой операции создания и переноса нужно нажать 

кнопку «Apply». 

Результат отображен на рисунке 1.9. 

 

Рисунок 1.9 – Несколько построенных объемов 

 

ж) Далее создается параллелепипед: 

Geometry → Volume → Create Volume → Brick 

Размеры - Width = 0.2, Depth = 0.7, Height = 0.2 

Для выполнения операции нужно нажать кнопку «Apply» 

з) Выполняется перемещение параллелепипеда: 

Geometry → Volume → Move/Copy/Align 

Координаты перемещения - Х = 0.2, Y = 0.35, Z = 0.1 

Для выполнения операции нужно нажать кнопку «Apply». В результате, 

построенные объемы будут расположены в соответствии с рисунком 1.10. 
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Рисунок 1.10 – Расположение построенных объемов 

 

и) Следующим шагом выполняется объединение всех объемных фигур, 

кроме центрального цилиндра: 

Geometry → Volume → Boolean Operations → Unite 

Выбираются мышью фигуры, кроме Volume 5: Volume 1, 

Volume 2, Volume 3, Volume 4, Volume 6. 

Для выполнения операции нужно нажать кнопку «Apply» 

к) Далее производится «вычитание» объемов: 

Geometry → Volume → Boolean Operations → Substract 

Выбирается мышью объем Volume 6, получившийся в результате 

операции Unite, затем выбирается оставшийся объем цилиндра: subtract 

Volume: Volume 5. Необходимо убедится, что выбрана опция «retain» в меню 

subtract Volume. 

Для выполнения операции нужно нажать кнопку «Apply» (рисунок 

1.11). 
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Рисунок 1.11 – Вычитание объемов 

 

л) Далее необходимо связать отдельные объемы с помощью поверхности 

соприкосновения: 

Geometry → Face → Connect/Disconnect Faces → Connect 

С нажатой клавишей Shift выберите мышью поверхности, 

располагающиеся между объемами, только те из них, которые по равны по 

размеру окружности маленького цилиндра (рисунок 1.12). Эта операция 

необходима для соединения объемов. В результате это приведет к удалению 

одной из поверхностей, которые расположены на одном и том же месте. 

После выполнения операции два объема станут связаны одной 

поверхностью, что приведет потом к тому, что с обоих сторон объемов будет 

сгенерирована одна и та же сетка. Несоединенные поверхности по 

умолчанию считаются стенками. В нашем случае боковая поверхность 

центрального цилиндра будет непроницаемой стенкой. 

После выбора поверхностей нужно нажать кнопку «Apply». 
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Рисунок 1.12 – Поверхности, которые должны быть выбраны для операции соединение 

плоскостей 

 

1.5 Указание граничных поверхностей 

В программе ANSYS Gambit осуществляется указание поверхностей 

вход и выход из расчетной области циклона, к которым будут приложены 

граничные условия. Численные значения граничных условий задаются в 

программе ANSYS Fluent. Поверхности, которые не будут указаны как 

граничные, по умолчанию считаются стенками и к ним применяется 

соответствующее граничное условие wall. Дополнительно пылеуловитель 

должен быть помечен как отдельная стенка, это необходимо для 

моделирования дисперсной фазы. Указанный в программе ANSYS Gambit тип 

граничного условия в случае ошибок или изменения стратегии решения 

можно поменять в ANSYS Fluent. 

Выполняется задание граничных условий следующим алгоритмом: 

а) Для входной поверхности задается условие скорости потока: 
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Zones → Specify Boundary Types 

Обязательно необходимо включение опции Add 

Задается имя Name: in 

Выбирается тип ГУ Select Type VELOCITY INLET 

Далее нужно выбрать поверхность Entity: Faces, представляющую вход 

в циклон, в соответствии с рисунком 1.13. 

Для выполнения операции нужно нажать кнопку «Apply». 

б) Для выходной поверхности задается условие расхода: 

Zones → Specify Boundary Types 

Опция Add включена. 

Задается имя Name: out 

Выбирается тип ГУ Select Type OUTFLOW 

Далее нужно выбрать поверхность, представляющую выход из 

циклона, показанную на рисунке 1.13. 

Для выполнения операции нужно нажать кнопку «Apply». 

в) Для поверхностей пылеуловительной зоны применяется условие стенки: 

Zones → Specify Boundary Types 

Опция Add включена. 

Задается имя Name: ash 

Выбирается тип ГУ Select Type WALL 

Выбираются поверхности, образующие пылеуловитель. 

Для выполнения операции нужно нажать кнопку «Apply». 
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Рисунок 1.13 – Поверхности для задания граничных условий 

 

В результате операций по назначению ГУ модель будет выглядеть как 

на рисунке 1.14. 
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Рисунок 1.14 – Отображение поверхности с заданными граничными условиями 

 

1.6 Разбиение конечно-элементной сеткой геометрической модели 

Генерирование подходящей сетки для геометрической модели циклона 

не является тривиальной задачей. Поток внутри циклона полностью 

трехмерный и сложный.  Правильное моделирование таких потоков требует 

тщательной обработки сетки. Так как цель данного учебного пособия – 

продемонстрировать основные этапы моделирования вихревого движения 

потока в ANSYS Fluent, используется упрощенный генератор сетки. 

Показанную здесь сетку не следует использовать для моделирования 

реальных объектов и НИР. Ниже представлен алгоритм построения сетки для 

циклона. 

а) Для начала сеткой разбиваются поверхности модели: 

Mesh → Face 

Необходимо выбрать все поверхности в окне Pick Faces. 

Выбирается тип элемента (треугольник) Select Elements: Tri 

Выбирается схема разбиения Select Type: Pave. 
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Включается опция Check Spacing: Apply. 

Вводится интервал разбиения Enter Interval size 0.05. 

Для выполнения операции нужно нажать кнопку «Apply». 

Результат разбиения поверхностей конечно-элементной сеткой 

представлен на рисунке 1.15. 

 

Рисунок 1.15 – Поверхности модели с конечно-элементной сеткой 

 

б) Далее модель разбивается конечными объемами: 

Mesh → Volume 

Необходимо выбрать все объемы в окне Pick Volumes. 

Выбирается тип элемента Select Elements: Tet/Hybrid. 

Выбирается схема разбиения Select Type: Tgrid. 

Необходимо отключить опцию Uncheck Spacing: Apply. 

Для выполнения операции нужно нажать кнопку «Apply». 

Результат разбиения объемной конечно-элементной сеткой 

представлен на рисунке 1.16. 
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Рисунок 1.16 – Модель циклона с объемной конечно-элементной сеткой сеткой 

 

Созданная объемная сетка содержит примерно 20000 ячеек. Последний 

этап работы в ANSYS Gambit – это экспорт cгенерированной трехмерной 

сетки. 

File → Export → Mesh 

Кнопкой Browse выбирается назначенная рабочая папка. Далее 

необходимо ввести имя файла (cyclon), расширение будет дано 

автоматически (рисунок 1.17). 

 

Рисунок 1.17 – Окно экспорта сеточной трехмерной модели 

Для выполнения процедуры необходимо нажать кнопку «Accept». 
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2 РАСЧЕТ ПРОЦЕССОВ ВНУТРИ ЦИКЛОНА В ANSYS Fluent 

 

2.1 Загрузка сеточной модели в ANSYS Fluent 

Здесь указана процедура настройки решателя ANSYS Fluent для расчета. 

В окне запуска программы ANSYS Fluent в поле Working Directory 

необходимо указать ранее созданную рабочую папку содержащую 

сохраненный в 1 главе файл cyclone.msh, остальные параметры указать в 

соответствии с рисунком 2.1. 

 

Рисунок 2.1 – Меню запуска ANSYS Fluent 

Для запуска ANSYS Fluent нужно нажать на клавишу ОК. 

Далее загружается файл сетки (cyclone.msh): 

File → Read → Mesh 

Программа ANSYS Fluent cчитает файл и отображает ход чтения в окне 

командной строки. 
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После загрузки файла в окне программы отобразится сеточная модель 

(рисунок 2.2). 

 

Рисунок 2.2 – Окно ANSYS Fluent с загруженной моделью 

 

2.2 Установка параметров решателя ANSYS Fluent 

Настройки решателя в меню General остаются по умолчанию (рисунок 

2.3). 

Параметры граничных условий, которые будут использованы в ANSYS 

Fluent представлены в таблице 1. 

Таблица 1 - Рабочие параметры циклона 

Расход воздуха 0,27 м
3
/с 

Температура воздуха 50 
о
С 

Массовый расход пыли 0,001 кг/с 

Мин. диаметр частицы пыли 1 мкм 

Макс. диаметр частицы пыли 300 мкм 

Средний диаметр частицы пыли 150 мкм 
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Параметр рассеяния 2,8  

Плотность пыли 2100 кг/м
3
 

 

 

 

Рисунок 2.3 – Меню опций решателя (Solver) 

 

Для обеспечения высокой точности расчетов необходимо выбрать 

соответствующую для данной задачи модель турбулентности. Учитывая 

характер задачи, рекомендуется использовать k-ε (RNG) модель 

турбулентности c опцией Swirl Dominated Flow (рисунок 2.4). Для этого 

настройка модели турбулентности вызывается следующим образом: 

Define → Models →Viscous 
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Рисунок 2.4 – Меню выбора модели турбулентности(Viscous Model) 

 

При решении данной задачи нужно обязательно учитывать теплообмен и 

теплопередачу. Для этого необходимо подключить к решению уравнение 

энергии с помощью команды: 

Define → Models → Energy 

 

Рисунок 2.5 – Меню включения уравнения энергии (Energy) 

В появившемся окне нужно поставить галочку в строке Energy Equation  

и нажать ОК  (рисунок 2.5). 
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Далее включается модель Discrete Phase. В панели Discrete Phase Model 

вводится значение 10000 для Maximum Number of Steps и включается опция 

Interaction with Continuos Phase (рисунок 2.6). 

 

Рисунок 2.6 – Меню модели дискретной фазы 

 

В этом же меню кнопкой Injections… включается подача пыли. В окне 

Injections нужно нажать клавишу Create. В появившемся окне Set Injection 

Properties задаются следующие настройки (рисунок 2.7): 
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Рисунок 2.7 – Меню задания подачи пыли 

а) Injection Type → surface; 

б) в окне Release From Surfaces выбирается in – имя поверхности входа 

в циклон; 

в) Material → ash 

г) Diameter Distribution → rosin-rammler-logarithmic 

д) в таблице Point Properties указываются значения (рисунок 2.8): 

Total Flow Rate (kg/s) = 0.001 

Min. Diameter (m) = 1e-6 

Max. Diameter (m) = 300е-6 

Mean Diameter (m) = 150e-6 

Spread Parameter = 2.8 
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Number of Diameters = 15 

 

Рисунок 2.8 – Меню задания подачи пыли 

е) В поле Turbulent Dispersion в пункте Stochastic Tracking включается 

Discrete Random Walk Model и вводится Number of Tries равное 5 (рисунок 

2.9). 
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Рисунок 2.9 – Меню задания подачи пыли 

Для применения изменений нужно нажать ОК. 

 

Задаются свойства материалов Define → Materials... (рисунок 2.10). 
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Рисунок 2.10 – Меню задания свойств воздуха 

 

Для плотности воздуха Density (kg/m3) вводится 1,094 

Для подтверждения изменения необходимо нажать кнопку Change 

Create. 

Аналогичным образом для inert-particle ash задается плотность Density 

(kg/m3) равная 2100. 

Для подтверждения изменения необходимо нажать кнопку Change 

Create. 

 

Далее определяются условия работы: 

Define → Operating Conditions... (рисунок 2.11). 
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Рисунок 2.11 – Меню Operation Conditions 

 

Для Operation Pressure вводится 0 Па. 

Включается Gravity и вводится ускорение свободного падения по оси Z 

(m/s2), равное 9.81. 

Для применения изменений нужно нажать ОК. 

 

Задаются параметры для граничных условий (рисунок 2.12): 

Define → Boundary Conditions... 
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Рисунок 2.12 – Меню Boundary Conditions 

 

Выбирается зона in, нажимается клавиша Edit (рисунок 2.13). 

 

Рисунок 2.13 – Меню настройки ГУ (in) 
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В открывшемся окне для Velocity Magnitude (m/s) вводится 7,98. 

Для Supersonic/Initial Gauge Pressure (pascal) вводится 100000. 

Для Turbulence Specification Method выбирается Intensity and Hydraulic 

Diameter. 

Для Hydraulic Diameter (m) вводится 0,2. 

Для применения изменений нужно нажать ОК. 

 

Далее выбирается зона ash, нажимается клавиша Edit. 

Далее нужно перейти во вкладку DPM (рисунок 2.14). 

 

Рисунок 2.14 – Меню настройки ГУ (ash) 

 

В окне Discrete Phase Model Condition выбирается Boundary Cond. Type 

→ trap. 

Для применения изменений нужно нажать ОК. 

 

Далее выбирается зона wall, нажимается клавиша Edit. 
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Далее нужно перейти во вкладку DPM (рисунок 2.15): 

 

Рисунок 2.15 – Меню настройки ГУ (wall) 

 

Под Discrete Phase Reflection Coefficients нужно выбрать: 

Normal→ constant 

и ввести значение, равное 0,8. 

Tangent→ constant 

и ввести значение, равное 0,8. 

Для применения изменений нужно нажать ОК. 

 

Следующий шаг - установка параметров решателя Solution Methods 

(рисунок 2.16). 
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Рисунок 2.16 – Меню настройки решателя 

 

В Momentum выбирается Second Order Upwind. 

В Turbulent Kinetic Energy выбирается Second Order Upwind. 

В Turbulent Dissipation Rate выбирается Second Order Upwind. 

Для применения изменений нужно нажать ОК. 

 

Затем следует установить параметры начальных условий для области 

потока с помощью процесса инициализации процесса решения 

(рисунок 2.17): 

Solve → Initialization... 
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Рисунок 2.17 – Меню инициализации решателя 

 

При этом выполняются следующие действия: 

а) В строке Gauge Pressure вводится  значение «100000». 

б) В строке X Velocity вводится  значение «0». 

в) В строке Y Velocity вводится  значение «0». 

г) В строке Z Velocity вводится  значение «0». 

д) В строке Temperature вводится значение «300». 

е) Затем следует нажать клавишу Initialize. 

Для выполнения инициализации следует нажать клавишу  Initialize 

 

Для настройки опций мониторинга решения нужно перейти в Solution→ 

Monitors → Residual... (рисунок 2.18). 
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Рисунок 2.18 – Меню настройки опций мониторинга решения 

 

Под Option выбирается Plot. 

Для Residual → continuity → Convergence Criterion вводится значение 

10е-9. 

Для применения изменений нужно нажать ОК. 

 

После произведённых настроек необходимо сохранить файл проекта 

ANSYS Fluent (файл проекта имеет расширение .cas): 

File→ Write→ Case… 

Вводится имя файла (Cyclon), и для подтверждения нужно нажать ОК. 

 

2.2 Выполнение расчета 

Для запуска процесса расчета нужно перейти в меню Run Calculation 

(рисунок 2.19). 
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Рисунок 2.19 – Меню запуска решения 

 

В поле Number of iterations нужно ввести 100 (тем самым будет 

запущено 100 итераций решения). 

Для запуска процесса решения необходимо нажать клавишу Calculate. 

После этого в основном окне ANSYS Fluent можно будет наблюдать 

отображение результатов решения уравнений и невязок (рисунок 2.20). 
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Рисунок 2.20 – Процесс решения задачи 

 

Создание плоскостей для извлечения расчетных переменных 

После проведения расчета можно наглядно получить доступ к 

рассчитанным значениям внутри пространства модели. Используя 

постпроцессор ANSYS Fluent, можно отобразить только значения на внешней 

поверхности модели. Для доступа к значениям внутри пространства модели 

необходимо создать секущие плоскости. Плоскости могут размещаться в 

местах, выбранных пользователем. Из всех способов определения позиций 

рекомендуется использовать метод трех точек, описанный ниже. 

В случае, если мы не помним геометрические размеры объекта и его 

размещение в декартовой системе координат, мы может отобразить 

декартовы координаты на внешней поверхности объекта (см. список ниже). 

 

Ось циклона совмещена с осью Z и пересекает Х=0 и Y=0. Нужно 

создать плоскость, пересекающую циклон при Y=0. Для этого: 
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Выбирается Surface → Plane... 

В меню Points вводится: 

x0(m) = 1; x1(m) = 0; x2(m) = 0 

y0(m) = 0; y1(m) = 0; y2(m) = 0 

z0(m) = 0; z1(m) = 0; z2(m) = 1 

(конкретные значения переменных не важны, точки могут не совпадать 

и в конкретном случае все значения y должны быть равны 0). 

В New Surface Name вводится желаемое имя поверхности. 

Для выполнения операции нужно нажать Create. 

Далее можно закрыть панель Plane Surface, нажав Close. 

 

Указанную выше процедуру можно повторять для создания 

дополнительных плоскостей в позициях внутри анализируемого 

пространства. Можно увидеть созданные плоскости, отображая их в окне 

результатов ANSYS Fluent: 

Выбирается Display  → Contours... 

В этом же окне нужно выбрать Filled в Options 

В Contours of выбрать Pressure... → Static Pressure 

В Surface выбрать имя ранее созданной плоскости (plane-1) и нажать 

Display (рисунок 2.21). 
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Рисунок 2.21 – Отображение результатов решения на секущей плоскости 

 

В результате в окне ANSYS Fluent можно наблюдать плоскости, с полем 

распределения различных параметров. 

 

Чтобы просмотреть движение частиц пыли внутри модели нужно: 

Выбрать Display → Particle Tracks... (рисунок 2.22). 
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Рисунок 2.22 – Отображение просмотра движения частиц 

 

В Option активировать Draw Mesh для того, чтобы увидеть границы 

модели. 

В Release from Injections выбрать injection-0 (имя может отличаться). 

Включить Track Single Particle Stream, (число отслеживаемых частиц 

обычно превосходит тысячу и процедура слежения продолжительна даже на 

быстрых компьютерах, для того чтобы ускорить этот процесс и увидеть 

траектории частиц на экране выбирается эта опция → частицы будут 

посылаться только из одной поверхности на входе). 

Далее нужно нажать Display (ANSYS Fluent начнет процедуру 

слежения, после окончания будет отображены траектории частиц в основном 

окне) (рисунок 2.23). 



43 

 

 

Рисунок 2.23 – Отображение движения частиц и статистики 

 

В области командной строки ANSYS Fluent печатается отчет о 

процедуре отслеживания частиц. Отчет показывает, сколько частиц было 

отслежено, удержано (trapped), выброшено (escaped), не учтено (aborted), и 

не завершило движения (incomplete). 

Удержанные частицы содержатся в пылеуловителе. 

Выброшенные частицы - покинувшие циклон через выход. 

Не учтенные – частицы, которые не отслежены решателем из-за 

численной ошибки. 

Не завершившие движение - частицы, для которых максимальное число 

шагов не было достаточно для завершения пути. 
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Полезная функция в процедуре слежения – сводный отчет. Он может 

помочь в оценке эффективности циклона, которая рассчитывается как 

отношения массы пыли, содержащейся в пылесборнике, к массе пыли, 

вошедшей в циклон. Он также приводит информацию о массе пыли, не 

завершившей движение. 

В панели Within Particle Tracks нужно выбрать Summary в Report Type. 

Далее снять выбор на Track Single Particle Stream. 

Нажать Track, (потоки частиц не будут отображаться в основном окне) 

Пример сводного отчета приведен ниже на рисунке 2.24. 

 

Рисунок 2.24 – Сводный отчет по частицам пыли 

 

Самый интересный элемент отчета - Mass Transfer Summary, который 

показывает массовые расходы не завершивших движение, удержанных и 

вылетевших частиц. Иногда даже большое число вылетевших частиц не 

говорит о низкой эффективности циклона, так как эти частицы могут быть 

малого диаметра. Следовательно, для оценки эффективности циклона 

массовые расходы пойманных и сбежавших частиц должны сравниваться. 

Число не завершивших движение частиц показывает сколькими частицами не 

были завершены траектории движения. Они не являются ни удержанными, 

ни вылетевшими и их отслеживание не было завершено внутри модели. Если 

число и массовый поток этих частиц велики, то рекомендуется увеличить 

максимальное число шагов в панели Discrete Phase Model в меню Models. 
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ЗАКЛЮЧЕНИЕ 

Применение CAD/CAE – технологий для проведения эксперимента по 

моделированию процесса очистки газового потока в циклонном осадителе, 

для которого сначала была создана компьютерная модель, выполнено ее 

разбиение конечно-элементной сеткой с последующей настройкой решателя 

программного комплекса ANSYS Fluent позволяет снизить сроки 

проектирования за счет ускорения процесса расчета, а также оценить с 

достаточной  точностью эффективность и производительность выбранной 

геометрии конструкции. 

Высокая информативность результатов численного моделирования 

способствует более детально анализировать процесс пылеочистки. 
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